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 Important Information

Warranty
The NI ELVIS hardware is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as 
evidenced by receipts or other documentation. The NI ELVIS software is warranted against defects in materials and workmanship for a period 
of 90 days from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace 
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be commercially reproduced or transmitted in any form, electronic or mechanical, including 
photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of 
National Instruments Corporation.

Trademarks
LabVIEW™, National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

FCC/Canada Radio Frequency Interference Compliance

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products.
Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the 
Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital 
electronics emit weak signals during normal operation that can affect radio, television, or other wireless products.
All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated.
Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department of 
Communications (DOC). 
Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the FCC 
Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference 
at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance to EU Directives
Readers in the European Union (EU) must refer to the manufacturer’s Declaration of Conformity (DoC) for information* 
pertaining to the CE marking compliance scheme. The manufacturer includes a DoC for most hardware products except for those 
bought from OEMs. In addition, DoCs are usually not provided if compliance is not required, for example electrically benign 
apparatus or cables.
To obtain the DoC for this product, click Declaration of Conformity at ni.com/hardref.nsf/. This Web site lists the DoCs 
by product family. Select the appropriate product family, followed by your product, and a link to the DoC appears in Adobe 
Acrobat format. Click the Acrobat icon to download or read the DoC.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.
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About This Manual

Thank you for purchasing the National Instruments Educational 
Laboratory Virtual Instrumentation Suite (NI ELVIS). The NI ELVIS User 
Manual contains information that you need to understand and program the 
NI ELVIS architecture and instruments. The NI ELVIS User Manual also 
discusses the components of an NI data acquisition (DAQ) system and the 
concept of virtual instrumentation.

Conventions
The following conventions appear in this manual:

<> Angle brackets that contain numbers separated by an ellipsis represent a 
range of values associated with a bit or signal name—for example, 
DIO<3..0>.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on 
the product, refer to the Safety Information section of Chapter 1, DAQ 
System Overview, for precautions to take.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names and hardware labels.

DAQ device DAQ device refers to any National Instrument DAQ device that meets the 
conditions listed in the DAQ Hardware section of Chapter 3, Hardware 
Overview.

ELVIS Educational Laboratory Virtual Instrumentation Suite

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.
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monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames and extensions, and code excerpts.

PCI Peripheral Component Interconnect—a high-performance expansion bus 
architecture originally developed by Intel to replace ISA and EISA

Related Documentation
The following documents contain information that you might find helpful 
as you read this manual:

• DAQ device user manual, available at ni.com/manuals

• Getting Started with LabVIEW, available at ni.com/manuals

• LabVIEW Help, available by selecting Help»VI, Function, and 
How-To Help from the LabVIEW block diagram or front panel

• LabVIEW Measurements Manual, available at ni.com/manuals

• Measurement & Automation Explorer Help for DAQ, available by 
selecting Help»Help Topics»NI-DAQ from the Measurement & 
Automation Explorer (MAX) window

• Where to Start with NI ELVIS, available in PDF format on the 
NI ELVIS Software CD

• NI ELVIS Online Help, available on the NI ELVIS Software CD or 
from ni.com/manuals
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1
DAQ System Overview

This chapter briefly describes the concept of DAQ systems and introduces 
NI ELVIS, a DAQ system designed for educational laboratories.

What is DAQ?
DAQ systems capture, measure, and analyze physical phenomena from the 
real world. Light, temperature, pressure, and torque are examples of the 
different types of signals that a DAQ system can measure. Data acquisition 
is the process of collecting and measuring electrical signals from 
transducers and test probes or fixtures, and sending them to a computer for 
processing. Data acquisition may also include the output of analog or 
digital control signals.

The building blocks of a DAQ system include the following items:

• Transducer—A device that converts a physical phenomenon such as 
light, temperature, pressure, or sound into a measurable electrical 
signal such as voltage or current.

• Signal—The product of the DAQ system transducer.

• Signal conditioning—Hardware that you can connect to the 
DAQ device to make the signal suitable for measurement or to 
improve accuracy or reduce noise. The most common types of signal 
conditioning include amplification, excitation, linearization, isolation, 
and filtering.

• DAQ hardware—Hardware you use to acquire, measure, and analyze 
data.

• Software—NI application software is designed to help you easily 
design and program your measurement and control application.
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Figure 1-1 shows the components of a typical DAQ system.

Figure 1-1.  Typical DAQ System

The NI ELVIS incorporates DAQ hardware and software, the last two of 
the DAQ system components, into one product. The following sections 
give more information about DAQ hardware and software, which is 
LabVIEW in the case of NI ELVIS.

DAQ Hardware
Since DAQ devices acquire electrical signals, a transducer or a sensor must 
convert some physical phenomenon into an electrical signal. A DAQ 
system can also simultaneously produce electrical signals. These signals 
can either intelligently control mechanical systems or provide a stimulus so 
that the DAQ system can measure a response. Most DAQ devices have four 
standard elements: analog input (AI), analog output (AO), 
digital I/O (DIO), and counter/timers. The most common National 
Instruments DAQ devices are the E Series devices.

The DAQ Hardware section of Chapter 3, Hardware Overview, describes 
in greater detail the DAQ device used as part of the NI ELVIS. Refer to the 
DAQ device user manual, at ni.com/manuals for specific information 
about the functionality and operation of the device.

Transducers

Signal
Conditioning

Data Acquisition
and Analysis
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Personal
Computer
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LabVIEW
LabVIEW is a graphical programming language frequently used for 
creating test, measurement, and automation applications. LabVIEW uses 
icons instead of lines of text to create applications. Unlike text-based 
programming languages, LabVIEW uses dataflow programming, where 
the flow of data determines execution. In LabVIEW, you build a user 
interface by using a set of tools and objects. The user interface is known as 
the front panel. You then add code using graphical representations of 
functions to control the front panel objects. The block diagram contains this 
code. In some ways, the block diagram resembles a flowchart. A virtual 
instrument (VI) is a LabVIEW program that models the appearance and 
function of a physical instrument.

The flexibility, modular nature, and ease-of-use programming possible 
with LabVIEW makes it popular in top university laboratories. With 
LabVIEW, you can rapidly create applications using intuitive graphical 
development and add user interfaces for interactive control. Scientists and 
engineers can use the straightforward I/O functionality of LabVIEW along 
with its analysis capabilities. LabVIEW can also be used in the classrooms 
to solve purely analytical or numerical problems.

For more information on programming with LabVIEW, refer to Getting 
Started with LabVIEW and the LabVIEW Measurements Manual, available 
at ni.com/manuals. LabVIEW Help is available by selecting 
Help»VI, Function, and How-To Help from the LabVIEW block 
diagram or front panel, or you can select Help»Search the LabVIEW 
Bookshelf from the block diagram or front panel to display other relevant 
LabVIEW documentation.

Virtual Instrumentation
Virtual instrumentation is defined as the combination of measurement 
and control hardware and application software with industry-standard 
computer technology to create user-defined instrumentation systems.

Virtual instrumentation provides an ideal platform for developing 
instructional curriculum and conducting scientific research. In an 
instructional laboratory course, students perform various experiments that 
combine measurements, automation, and control. Tools or systems used in 
these situations must be flexible and adaptable. In research environments, 
virtual instrumentation provides the flexibility that a researcher must have 
to modify the system to meet unpredictable needs. Research and 
instructional efforts also require that their systems be economical. Since 
you can reuse components in a virtual instrumentation system (without 
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purchasing additional hardware or software), virtual instrumentation is an 
economical choice. Finally, measurement systems must be scalable to meet 
future expansion needs. The modular nature of virtual instrumentation 
makes it easy for you to add new functionality.

NI ELVIS Overview
NI ELVIS uses LabVIEW-based software instruments, a multifunction 
DAQ device, and a custom-designed benchtop workstation and prototyping 
board to provide the functionality of a suite of common laboratory 
instruments.

The LabVIEW software that you use to interact with the NI ELVIS 
Benchtop Workstation and the DAQ device provides a high-level 
programming environment for easy implementation of the sophisticated 
display and analysis capabilities required for virtual instrumentation.

The NI ELVIS hardware provides a Function Generator and Variable 
Power Supplies from the benchtop workstation. The NI ELVIS LabVIEW 
soft front panel instruments combined with the functionality of the 
DAQ device provide the functionality of the following SFP instruments:

• Arbitrary Waveform Generator (ARB)

• Bode Analyzer

• Digital Bus Reader

• Digital Bus Writer

• Digital Multimeter (DMM)

• Dynamic Signal Analyzer (DSA)

• Function Generator (FGEN)

• Impedance Analyzer

• Oscilloscope (Scope)

• Two-Wire Current Voltage Analyzer

• Three-Wire Current Voltage Analyzer

• Variable Power Supplies

Refer to Figure 2-1, The NI ELVIS System, in Chapter 2, NI ELVIS 
Overview, for an illustration of the NI ELVIS.
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Safety Information
The following section contains important safety information that you must 
follow when installing and using the product.

Do not operate the product in a manner not specified in this document. 
Misuse of the product can result in a hazard. You can compromise the 
safety protection built into the product if the product is damaged in any 
way. If the product is damaged, return it to National Instruments for repair.

Do not substitute parts or modify the product except as described in this 
document. Use the product only with the chassis, modules, accessories, and 
cables specified in the installation instructions. You must have all covers 
and filler panels installed during operation of the product.

Do not operate the product in an explosive atmosphere or where there may 
be flammable gases or fumes. If you must operate the product in such an 
environment, it must be in a suitably rated enclosure.

If you need to clean the product, use a soft, nonmetallic brush. Make sure 
that the product is completely dry and free from contaminants before 
returning it to service.

Operate the product only at or below Pollution Degree 1. Pollution is 
foreign matter in a solid, liquid, or gaseous state that can reduce dielectric 
strength or surface resistivity. The following is a description of pollution 
degrees:

• Pollution Degree 1 means no pollution or only dry, nonconductive 
pollution occurs. The pollution has no influence.

• Pollution Degree 2 means that only nonconductive pollution occurs in 
most cases. Occasionally, however, a temporary conductivity caused 
by condensation must be expected.

• Pollution Degree 3 means that conductive pollution occurs, or dry, 
nonconductive pollution occurs that becomes conductive due to 
condensation.

You must insulate signal connections for the maximum voltage for which 
the product is rated. Do not exceed the maximum ratings for the product. 
Do not install wiring while the product is live with electrical signals. Do not 
remove or add connector blocks when power is connected to the system. 
Avoid contact between your body and the connector block signal when hot 
swapping modules. Remove power from signal lines before connecting 
them to or disconnecting them from the product.
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Operate the product at or below the installation category1 marked on the 
hardware label. Measurement circuits are subjected to working voltages2 
and transient stresses (overvoltage) from the circuit to which they are 
connected during measurement or test. Installation categories establish 
standard impulse withstand voltage levels that commonly occur in 
electrical distribution systems. The following is a description of installation 
categories:

• Installation Category I is for measurements performed on circuits not 
directly connected to the electrical distribution system referred to as 
MAINS3 voltage. This category is for measurements of voltages from 
specially protected secondary circuits. Such voltage measurements 
include signal levels, special equipment, limited-energy parts of 
equipment, circuits powered by regulated low-voltage sources, and 
electronics.

• Installation Category II is for measurements performed on circuits 
directly connected to the electrical distribution system. This category 
refers to local-level electrical distribution, such as that provided by a 
standard wall outlet (for example, 115 V for U.S. or 230 V for Europe). 
Examples of Installation Category II are measurements performed on 
household appliances, portable tools, and similar product.

• Installation Category III is for measurements performed in the building 
installation at the distribution level. This category refers to 
measurements on hard-wired equipment such as equipment in fixed 
installations, distribution boards, and circuit breakers. Other examples 
are wiring, including cables, bus-bars, junction boxes, switches, 
socket-outlets in the fixed installation, and stationary motors with 
permanent connections to fixed installations.

• Installation Category IV is for measurements performed at the primary 
electrical supply installation (<1,000V). Examples include electricity 
meters and measurements on primary overcurrent protection devices 
and on ripple control units.

1   Installation categories, also referred to as measurement categories, are defined in electrical safety standard IEC 61010-1.
2   Working voltage is the highest rms value of an AC or DC voltage that can occur across any particular insulation.
3   MAINS is defined as a hazardous live electrical supply system that powers equipment. Suitably rated measuring circuits may 

be connected to the MAINS for measuring purposes.
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2
NI ELVIS Overview

NI ELVIS combines hardware and software into one complete laboratory 
suite. This chapter provides an overview of the hardware and software 
components of the NI ELVIS. Additionally, this chapter discusses how 
NI ELVIS can be used in various academic environments.

Chapter 3, Hardware Overview, provides more detailed information about 
NI ELVIS hardware components. Refer to the NI ELVIS Online Help for 
more information about the software components.

Refer to Figure 2-1 for a diagram of the NI ELVIS system.
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Figure 2-1.  The NI ELVIS System

NI ELVIS Hardware
The following sections briefly describe the hardware components of the 
NI ELVIS. For more specific information about these components, refer to 
Chapter 3, Hardware Overview.

1 Computer Running LabVIEW
2 DAQ Device
3 68-Pin E Series Cable

4 NI ELVIS Prototyping Board
5 NI ELVIS Benchtop Workstation

1

4

5

3

2
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NI ELVIS Benchtop Workstation
The benchtop workstation and the DAQ device together create a complete 
laboratory system. The workstation provides connectivity and 
functionality. The control panel on the workstation provides 
easy-to-operate knobs for the function generator and variable power 
supplies, and it offers convenient connectivity in the form of BNC and 
banana-style connectors to the NI ELVIS - Scope SFP and 
NI ELVIS - DMM SFP. The NI ELVIS software routes signals in the NI 
ELVIS Benchtop Workstation between the SFP instruments. For example, 
the output of the function generator may be routed to a specific channel of 
the DAQ device and ultimately acquired on a desired channel of the 
NI ELVIS - Scope SFP. The benchtop workstation also contains a 
protection board that protects the DAQ device from possible damage 
resulting from laboratory errors.

Refer to the NI ELVIS Benchtop Workstation section of Chapter 3, 
Hardware Overview, for more detailed information about the benchtop 
workstation, including the parts locator diagram.

NI ELVIS Prototyping Board
The NI ELVIS Prototyping Board connects to the benchtop workstation. 
The prototyping board provides an area for building electronic circuitry and 
allows the connections necessary to access signals for common 
applications. You can use multiple prototyping boards interchangeably 
with the NI ELVIS Benchtop Workstation.

Refer to the NI ELVIS Prototyping Board section of Chapter 3, Hardware 
Overview, for more information about the prototyping board, including 
signal descriptions, connection instructions, and the parts locator diagram.

NI ELVIS Software
The NI ELVIS software, created in LabVIEW, takes advantage of the 
capabilities of virtual instrumentation. The software includes two main 
types: the soft front panel (SFP) instruments and the LabVIEW API for 
programming the NI ELVIS hardware.

SFP Instruments
NI ELVIS ships with the SFP instruments, created in LabVIEW, and the 
source code for the instruments. You cannot directly modify the executable 
files, but you can modify or enhance the functionality of these instruments 
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by modifying the LabVIEW code. The instruments are virtual instruments 
(VIs) that are necessary in typical laboratory applications.

This section briefly describes each SFP instrument included with 
NI ELVIS. The instrument software is LabVIEW-based, so you can 
customize the instruments by modifying the LabVIEW code.

Instrument Launcher
The NI ELVIS Instrument Launcher provides access to the NI ELVIS 
software instruments. To launch an instrument, click the button 
corresponding to the desired instrument. If the NI ELVIS software is 
properly configured and the benchtop workstation is cabled to the 
appropriate DAQ device, all buttons should be visible.

If there is a problem with your configuration, such as when the NI ELVIS 
Benchtop Workstation is powered off or disconnected from the configured 
DAQ device, all instrument buttons are dimmed, and the only available 
option is to click the Configure button. Refer to Where to Start with the NI 
ELVIS for more information about configuring NI ELVIS.

Some instruments perform similar operations using the same resources of 
the NI ELVIS hardware and the DAQ device and cannot be run at the same 
time. If you launch two instruments with overlapping functionality that 
cannot run at the same time, the NI ELVIS software generates an error 
dialog describing the conflict. The instrument with the error is disabled and 
will not function until the conflict is resolved.

Arbitrary Waveform Generator (ARB)
This advanced-level SFP instrument uses the AO capabilities of the 
DAQ device. You can create a variety of signal types using the Waveform 
Editor software, which is included with the NI ELVIS software. You can 
load waveforms created with the NI Waveform Editor into the ARB SFP to 
generate stored waveforms. Refer to the NI ELVIS Online Help for more 
information about the Waveform Editor.

Since a typical DAQ device has two AO channels, two waveforms may be 
simultaneously generated. You can choose continuous output or a one-shot 
output. The minimum output rate of the NI ELVIS - ARB SFP is 
determined by the maximum update rate of the DAQ device connected to 
the NI ELVIS hardware. Refer to the DAQ device user manual for these 
specifications.
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Bode Analyzer
By combining the frequency sweep feature of the function generator and 
the AI capability of the DAQ device, a full-function Bode Analyzer is 
available with NI ELVIS. You can set the frequency range of the 
instrument and choose between linear and dB display scales.

Digital Bus Reader
This instrument reads digital data from the NI ELVIS digital input (DI) bus. 
You can either continuously read from the bus, or you can take a single 
reading.

Digital Bus Writer
This instrument updates the NI ELVIS digital output (DO) bus with 
user-specified digital patterns. You can manually create a pattern or select 
predefined patterns, such as ramp, toggle, or walking ones. This instrument 
can either continually output a pattern or just perform a single write. 
The output of the NI ELVIS - Digital Bus Writer SFP stays latched until 
the instrument is stopped or another pattern is output. Output voltage levels 
of the SFP are TTL compatible.

Digital Multimeter (DMM)
This commonly used instrument can perform the following types of 
measurements:

• DC voltage

• AC voltage

• Current (DC and AC)

• Resistance

• Capacitance

• Inductance

• Diode test

• Audible continuity

You can connect to the DMM from the NI ELVIS Prototyping Board or 
from the banana-style connectors on the front panel of the benchtop 
workstation.
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Dynamic Signal Analyzer (DSA)
This instrument is especially useful in advanced electrical engineering and 
physics classes. This instrument uses the analog input of the DAQ device 
to make measurements and can either continuously make measurements or 
make a single scan. You can also apply various window and filtering 
options to the signal.

Function Generator (FGEN)
This instrument provides you with choices for the type of output waveform 
(sine, square, or triangle), amplitude selection, and frequency settings. In 
addition, the instrument offers DC offset setting, frequency sweep 
capabilities, and modulation.

Impedance Analyzer
This instrument is a basic impedance analyzer that is capable of measuring 
the resistance and reactance for passive two-wire elements at a given 
frequency. 

Oscilloscope (Scope)
This instrument provides the functionality of the standard desktop 
instrument found in typical undergraduate laboratories. The 
NI ELVIS - Scope SFP has two channels and provides scaling and position 
adjustment knobs along with a modifiable timebase. You also can choose 
trigger source and mode settings. Depending on the DAQ device cabled to 
the NI ELVIS hardware, you can choose between digital or analog 
hardware triggering. You can connect to the NI ELVIS - Scope SFP from 
the NI ELVIS Prototyping Board or from the BNC connectors on the front 
panel of the benchtop workstation.

The FGEN or DMM signals can be routed to this instrument. In addition, 
this computer-based scope display has the ability to use cursors for accurate 
screen measurements. The sampling rate of the Oscilloscope is determined 
by the maximum sampling speed of the DAQ device installed in the 
computer attached to the NI ELVIS hardware.

Refer to the DAQ device user manual for information about the type of 
triggering supported on the device and for the specifications for the 
maximum sampling speed of the device.
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Two-Wire and Three-Wire Current-Voltage Analyzers
These instruments allow you to conduct diode and transistor parametric 
testing and view current-voltage curves. The two-wire instrument offers 
full flexibility in setting parameters such as voltage and current ranges and 
can save data to a file. In addition, the three-wire instrument offers base 
current settings for measurements of NPN transistors. Both instruments 
have cursors for more accurate onscreen measurements.

Variable Power Supplies
You can control the output of the positive or negative variable power 
supply with these SFP instruments. The negative power supply can output 
between –12 and 0 V, and the positive power supply can output between 
0 and +12 V.

Note For a detailed explanation of the soft front panel instruments and instructions for 
taking a measurement with each instrument, refer to the NI ELVIS Online Help.

NI ELVIS LabVIEW API
The NI ELVIS software also includes APIs to program four features of the 
NI ELVIS hardware: the DIO, DMM, FGEN, and Variable Power 
Supplies. Refer to Chapter 4, Programming NI ELVIS, for more 
information about using the APIs to program NI ELVIS.

Note For the VI reference for each API, refer to the NI ELVIS Online Help.

NI ELVIS in Academic Disciplines
You can use NI ELVIS in engineering, physical sciences, and biological 
sciences laboratories. NI ELVIS is suitable not only in terms of the 
included software, but also because of the custom signal conditioning 
hardware you can create with NI ELVIS. Instructors can implement the 
NI ELVIS curriculum with beginning to advanced classes to provide 
hands-on experience to students.

NI ELVIS in Engineering
NI ELVIS is suited for teaching basic electronics and circuit design to 
students in electrical engineering, mechanical engineering, and biomedical 
engineering. The suite offers full testing, measurement, and data-saving 
capabilities needed for such training. Students can use the removable 
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prototyping board at home to build circuits, thus using laboratory time 
more effectively.

NI ELVIS SFP instruments, such as the Bode Analyzer, offer instructors an 
opportunity to teach advanced courses in signal analysis and processing. 
Students may construct software filters in LabVIEW and hardware filters 
on the prototyping board and compare the performance of those two types 
of filters. 

Mechanical engineering students can learn sensor and transducer 
measurements in addition to basic circuit design by building custom signal 
conditioning. Students can install custom sensor adapters on the 
prototyping board. For example, installing a thermocouple jack on the 
prototyping board allows robust thermocouple connections. The 
programmable power supply can provide excitation for strain gauges used 
in strain measurements.

NI ELVIS in Biological Sciences
Biomedical engineering departments have challenges that are similar to 
those of mechanical departments. Students typically learn basic electronics 
and build instruments such as an electrocardiogram (ECG) monitor. 
The prototyping board offers signal conditioning capability for ECG 
sensors, and the NI ELVIS SFP instruments are ideal for testing the circuits 
as students build the signal conditioning circuits.

NI ELVIS in Physical Sciences
Physics students typically learn electronics and circuit design theory. 
NI ELVIS provides these students with the opportunity to implement these 
concepts. Physics students sometimes need signal conditioning for 
common sensors such as photoelectric multiplier or light detector sensors. 
Students can build high-gain, low-noise circuits on a printed circuit board 
(PCB) and use them in modern physics labs.

Caution The NI ELVIS hardware is not environmentally sealed; therefore, exercise 
extreme caution for use in chemical and biological sciences.
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3
Hardware Overview

This chapter describes the hardware components of the NI ELVIS, 
including the DAQ device, the benchtop workstation, and the prototyping 
board.

DAQ Hardware
NI ELVIS is designed to interact with National Instruments DAQ devices, 
which are high-performance, multifunction analog, digital, and timing I/O 
devices for PCI bus computers. Supported functions on DAQ devices 
include AI, AO, DIO, and timing I/O (TIO).

To use the NI ELVIS, the DAQ device installed in the computer connected 
to the NI ELVIS must have the following minimum requirements:

• 16 AI channels

• Two AO channels

• Eight DIO lines

• Two counter/timers

Note The NI ELVIS does not support 64 AI channel DAQ devices or DIO-only devices.

Using the DAQ Hardware in Bypass Mode
The NI ELVIS communicates with the computer through the eight DIO 
lines of the DAQ device. The Communications switch controls the routing 
of the DIO to the NI ELVIS. In normal operation, the switch is in Normal 
mode, and the DIO lines are routed to the NI ELVIS hardware, allowing 
software control. When the Communications switch is set to Bypass 
mode, the LED next to the switch is lit. No communication changes occur 
unless you use the NI ELVIS - Enable Communications Bypass VI in 
conjunction with putting the switch in Bypass mode. After you move the 
switch and run the VI, the DIO lines are routed to the DI lines on the 
prototyping board. Figure 3-1 shows the location of the Communications 
switch.
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When in Bypass mode, the hardware Function Generator and Variable 
Power Supplies are still available through the manual controls. The 
counter/timers, AI, and AO on the DAQ device are also available. The NI 
ELVIS SFP instruments notify you when the Communications switch is in 
Bypass mode. Some SFP controls are dimmed when the Communications 
switch is moved to Bypass mode.

For detailed information about the DAQ device, refer to the device user 
manual, which you can download at ni.com/manuals.

NI ELVIS Benchtop Workstation
This section describes the NI ELVIS Benchtop Workstation and the control 
panel on the front of the workstation.

Refer to Figure 3-1 for the parts locator diagram for the benchtop 
workstation.

Figure 3-1.  Control Panel Diagram of the Benchtop Workstation

The benchtop workstation has the following controls and indicators:

• System Power LED—Indicates whether the NI ELVIS is powered on.

• Prototyping Board Power Switch—Controls the power to the 
prototyping board.

1 System Power LED
2 Prototyping Board Power Switch
3 Communications Switch
4 Variable Power Supplies Controls

5 Function Generator (FGEN) Controls
6 DMM Connectors
7 Oscilloscope (Scope) Connectors

32 4 5 6 7

1

VARIABLE POWER SUPPLIES FUNCTION GENERATOR

PROTOTYPING BOARD
POWER

SYSTEM POWER MANUAL

20 VDC MAX
14 Vrms MAX

MANUAL MANUAL

FINE
FREQUENCY

AMPLITUDE

COARSE
FREQUENCY

VOLTAGEVOLTAGE

DMM SCOPE
CH A

CH B

TRIGGER

COMMUNICATIONS

NORMAL

BYPASS

FUSED AT 500 mA

HI

LO

HI

LO

W

250 kHz
50 kHz

5 kHz

500 Hz

–12 0 0

A

10 VDC, 7 Vrms MAX

VOLTAGECURRENTSUPPLY – SUPPLY +

ELECTROSTATIC
SENSITIVE

CONNECTORS

50 Hz

NI ELVIS

+12



Chapter 3 Hardware Overview

© National Instruments Corporation 3-3 NI ELVIS User Manual

• Communications Switch—Requests disabling software control of the 
NI ELVIS. This setting provides direct access to the DAQ device DIO 
lines. For more information about the Communications switch, refer 
to the Using the DAQ Hardware in Bypass Mode section.

• Variable Power Supplies Controls

Note You can control the variable power supplies through either the hardware controls on 
the benchtop workstation (Manual mode) or the controls on the NI ELVIS - Variable Power 
Supplies SFP (Software mode). You can only use the controls described in the following 
section when the variable power supplies are in Manual mode.

– Supply– Controls

• Manual Switch—Controls whether the negative supply is in 
Manual mode or Software mode.

• Voltage Adjust Knob—Controls the output of the negative 
supply. The negative supply can output between –12 and 0 V.

– Supply+ Controls

• Manual Switch—Controls whether the positive supply is in 
Manual mode or Software mode.

• Voltage Adjust Knob—Controls the output of the positive 
supply. The positive supply can output between 0 and +12 V.

For more information about the software controls for the Variable 
Power Supplies, refer to the NI ELVIS Online Help.

• Function Generator Controls

Note You can control the function generator through either the hardware controls on the 
benchtop workstation (Manual mode) or the controls on the NI ELVIS - FGEN SFP 
(Software mode). You can only use the controls described in the following section when 
the function generator is in Manual mode.

– Manual Switch—Controls whether the Function Generator is in 
Manual mode or Software mode.

– Function Selector—Selects what type of waveform is generated. 
NI ELVIS can generate sine, square, or triangle waves.

– Amplitude Knob—Adjusts the peak amplitude of the generated 
waveform.

– Coarse Frequency Knob—Sets the range of frequencies the 
Function Generator can output.



Chapter 3 Hardware Overview

NI ELVIS User Manual 3-4 ni.com

– Fine Frequency Knob—Adjusts the output frequency of the 
Function Generator.

For more information about the software controls for the function 
generator, refer to the NI ELVIS Online Help.

• DMM Connectors

Caution By connecting different signals to both the DMM terminals on the prototyping 
board and the DMM connectors on the control panel, you are shorting them together, 
potentially damaging the circuit on the prototyping board.

– CURRENT Banana Jacks

• HI—The positive input to all the DMM functionality, except 
measuring voltage.

• LO—The negative input to all the DMM functionality, except 
measuring voltage.

– VOLTAGE Banana Jacks

• HI—The positive input for voltage measurements.

• LO—The negative input for voltage measurements.

• Oscilloscope (Scope) Connectors

Caution By connecting different signals to the Scope terminals on the prototyping board 
and the Scope connectors on the control panel, you are shorting them together, potentially 
damaging the circuit on the prototyping board.

– CH A BNC Connector—The input for channel A of the 
Oscilloscope.

– CH B BNC Connector—The input for channel B of the 
Oscilloscope.

– Trigger BNC Connector—The input to the trigger of the 
Oscilloscope.

NI ELVIS Protection Board
NI ELVIS protects the DAQ device installed in the desktop computer by 
means of a protection board located inside the NI ELVIS Benchtop 
Workstation. This removable protection board provides short-circuit 
protection from unsafe external signals. Removing the protection board 
enables you to quickly replace a nonfunctioning board with a replacement 
unit. The components on the protection board are easily obtained from 
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electronics vendors and thus can be serviced without sending the board to 
NI for repairs.

Refer to Appendix B, Protection Board Fuses, for more information about 
changing the fuses on the NI ELVIS Protection Board.

NI ELVIS Prototyping Board
This section describes the NI ELVIS Prototyping Board and how you can 
use it to connect circuits to the NI ELVIS. This section also describes the 
signals that you can connect to the NI ELVIS from the prototyping board 
and the connectors you can use to do so.

The prototyping board connects to the benchtop workstation with a 
standard PCI connector, so you can create custom PCBs to interact with 
NI ELVIS. The prototyping board exposes all the signal terminals of the 
NI ELVIS to the user through the distribution strips on either side of the 
breadboard area. Each signal has a row, and the rows are grouped by 
function.
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Refer to Figure 3-2 for the parts locator diagram for the prototyping board.

Figure 3-2.  Prototyping Board Parts Locator Diagram

Prototyping Board Power
The prototyping board provides access to a ±15 V and a +5 V power 
supply. You can use these voltage rails to construct many common circuits. 
Refer to Appendix A, Specifications, for more information about these 
voltage rails.
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Prototyping Board Signal Descriptions
Table 3-1 describes the signals on the NI ELVIS prototyping board. The 
signals are grouped by the functionality section where they are located on 
the prototyping board.

Table 3-1.  Signal Descriptions

Signal Name Type Description

ACH<0..5>+ General AI Analog Input Channels 0 through 5 (+)—Positive differential input 
to the AI channels.

ACH<0..5>– General AI Analog Input Channels 0 through 5 (–)—Negative differential 
input to the AI channels.

AISENSE General AI Analog Input Sense—Reference for the analog channels in 
nonreferenced single-ended (NRSE) mode. For more information 
on AI modes, refer to the DAQ device user manual.

AIGND General AI Analog Input Ground—AI ground reference for the DAQ device. 
This ground signal is not tied to the NI ELVIS GROUND signals.

CH <A..B>+ Oscilloscope Oscilloscope Channels A and B (+)—Positive input for the 
Oscilloscope channels.

CH <A..B>– Oscilloscope Oscilloscope Channels A and B (–)—Negative input for the 
Oscilloscope channels.

TRIGGER Oscilloscope Oscilloscope Trigger—Trigger input for the Oscilloscope, 
referenced to AIGND.

PFI <1..2>, 
PFI <5..7>

Programmable Function I/O Programmable Function Input (PFI) 1 through 2 and 
5 through 7—Programmable function I/O of the DAQ device. For 
more information about the PFI lines, refer to the DAQ device user 
manual.

SCANCLK Programmable Function I/O Scan Clock—Connected to the SCANCLK pin of the DAQ device. 
For more information about the SCANCLK signal, refer to the 
DAQ device user manual.

RESERVED Programmable Function I/O Connected to the EXTSTROBE* pin of the DAQ device. For more 
information about the EXTSTROBE* signal, refer to the 
DAQ device user manual.

3-WIRE DMM Three Wire—Voltage source for the DMM for three-wire transistor 
measurements.

CURRENT HI DMM Positive Current—Positive input for the DMM for all 
measurements besides voltage.

CURRENT LO DMM Negative Current—Negative input for the DMM for all 
measurements besides voltage.

VOLTAGE HI DMM Positive Voltage—Positive input for the DMM voltmeter.
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VOLTAGE LO DMM Negative Voltage—Negative input for the DMM voltmeter.

DAC<0..1> General AO Analog Channel Output for Channels 0 through 1—Outputs of the 
DAQ device D/A converters (DACs). For more information about 
the DAQ device analog output signals, refer to the DAQ device 
user manual.

FUNC_OUT Function Generator Function Output—Output of the Function Generator.

SYNC_OUT Function Generator Synchronization Output—TTL signal of the same frequency as the 
output as the FUNC OUT pin.

AM_IN Function Generator Amplitude Modulation Input—Input to the amplitude modulator 
for the Function Generator.

FM_IN Function Generator Frequency Modulation Input—Input to the frequency modulator 
for the Function Generator.

BANANA <A..D> User Configurable I/O Banana Jacks A through D—Connects to the banana jacks pins.

BNC <1..2>+ User Configurable I/O BNC Connectors 1 and 2 (+)—Connects to the BNC pins.

BNC <1..2>– User Configurable I/O BNC Connectors 1 and 2 (–)—Connects to the BNC pins.

SUPPLY+ Variable Power Supplies Positive—Output of 0 to 12 V variable power supply.

SUPPLY– Variable Power Supplies Negative—Output of –12 to 0 V variable power supply.

GROUND Variable Power Supplies, 
DC Power Supplies

Ground—Prototyping board ground. These two ground signals are 
tied together.

+15 V DC Power Supplies +15 V Source—Output of fixed +15 V power supply, referenced to 
the NI ELVIS GROUND signal.

–15 V DC Power Supplies –15 V Source—Output of fixed –15 V power supply, referenced to 
the NI ELVIS GROUND signal.

+5V DC Power Supplies +5V Source—Output of fixed +5 V power supply, referenced to 
the NI ELVIS GROUND signal.

DO <0..7> DIO Digital Output Lines 0 through 7—Output of the write bus.

WR ENABLE DIO Write Enable—Output indicating data is being written to the write 
bus.

LATCH DIO Latch—Output that pulses after data is ready on the write bus.

GLB RESET DIO Global Reset—Output indicating global digital reset.

RD ENABLE DIO Read Enable—Output indicating data is being read from read bus.

DI <0..7> DIO Digital Input Lines 0 through 7—Output of read bus.

ADDRESS <0..3> DIO Address Lines 0 through 3—Output of address bus.

Table 3-1.  Signal Descriptions (Continued)

Signal Name Type Description
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Grounding Considerations
Because the analog channels are differential, you must establish a ground 
point somewhere in the signal path. As long as the signal you are measuring 
is referenced to one of the NI ELVIS GROUND pins, the measurement is 
correctly referenced. If a floating source, such as a battery, is being 
measured, be sure to connect one end of the signal to the NI ELVIS 
GROUND. Terminals for the NI ELVIS GROUND signal are located at 
several locations on the prototyping board. All these signals are tied 
together.

Connecting Analog Input Signals
This section describes how to connect AI signals on the NI ELVIS 
Prototyping Board. Refer to the DAQ device user manual for more 
information about types of signal sources, input modes, grounding 
configurations, and floating signal sources.

CTR0_SOURCE Counters Counter 0 Source—Connected to the GPCTR0_SOURCE pin on 
the DAQ device. For more information about the 
GPCTR0_SOURCE signal, refer to the DAQ device user manual.

CTR0_GATE Counters Counter 0 Gate—Connected to the GPCTR0_GATE pin on the 
DAQ device. For more information about the GPCTR0_GATE 
signal, refer to the DAQ device user manual.

CTR0_OUT Counters Counter 0 Output—Connected to the GPCTR0_OUT pin on the 
DAQ device. For more information about the GPCTR0_OUT 
signal, refer to the DAQ device user manual.

CTR1_GATE Counters Counter 1 Gate—Connected to the GPCTR1_GATE pin on the 
DAQ device. For more information about the GPCTR1_GATE 
signal, refer to the DAQ device user manual.

CTR1_OUT Counters Counter 1 Output—Connected to the GPCTR1_OUT pin on the 
DAQ device. For more information about the GPCTR1_OUT 
signal, refer to the DAQ device user manual.

FREQ_OUT Counters Frequency Output—Connected to the FREQ_OUT pin on the 
DAQ device. For more information about the FREQ_OUT signal, 
refer to the DAQ device user manual.

LED <0..7> User Configurable I/O LEDs 0 through 7—Input to the LEDs.

DSUB SHIELD User Configurable I/O D-Sub Shield—Connection to D-Sub shield.

DSUB PIN <1..9> User Configurable I/O D-Sub Pins 1 through 9—Connection to D-Sub pins.

Table 3-1.  Signal Descriptions (Continued)

Signal Name Type Description
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Generic Analog Input
The NI ELVIS Prototyping Board has six differential AI channels 
available—ACH<0..5>. These inputs are directly connected to the 
DAQ device input channels. The NI ELVIS also has two ground pins, 
AISENSE and AIGND, which are connected to the DAQ device ground 
pins. Table 3-2 shows how the NI ELVIS input channels map to the 
DAQ device input channels.

Table 3-2.  Analog Input Signal Mapping

NI ELVIS Input Channel DAQ Device Input Channel

ACH0+ ACH0

ACH0– ACH8

ACH1+ ACH1

ACH1– ACH9

ACH2+ ACH2

ACH2– ACH10

ACH3+ ACH3

ACH3– ACH11

ACH4+ ACH4

ACH4– ACH12

ACH5+ ACH5

ACH5– ACH13

AISENSE AISENSE

AIGND AIGND
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The following sections describe some special considerations for connecting 
the AI signals on the prototyping board, including sections that specifically 
pertain to the Oscilloscope and DMM.

Resource Conflicts
Some of the AI channels are used by the internal circuitry for other 
instruments, but the majority of the time the channel can still be used. 
ACH<0..2> can be used without interruption. ACH5 is interrupted if any of 
the impedance-analyzing capabilities of the DMM, such as the capacitance 
meter, diode tester, and so on, are used. If you are using the Oscilloscope, 
disconnect any signals from ACH3 and ACH4 to avoid double driving the 
channels.

Caution By connecting different signals to both the DMM terminals on the prototyping 
board and the DMM connectors on the control panel, you are shorting them together, 
potentially damaging the circuit on the prototyping board.

DMM
Both the CURRENT and VOLTAGE inputs are available on the 
prototyping board along with an additional terminal for three-wire 
transistor measurements. The differential voltmeter inputs are labeled 
VOLTAGE HI and VOLTAGE LO. The rest of the functionality of the 
DMM is available through the CURRENT HI and CURRENT LO pins. 
The 3-WIRE pin is used for three-terminal device measurements in 
conjunction with the CURRENT HI and CURRENT LO pins.

Caution By connecting different signals to the Scope terminals on the prototyping board 
and the Scope connectors on the control panel, you are shorting them together, potentially 
damaging the circuit on the prototyping board.

Oscilloscope
The inputs of the Oscilloscope are available on the prototyping board as 
CH <A..B>+, CH <A..B>–, and TRIGGER. CH <A..B> are directly 
connected to ACH3 and ACH4, respectively, on the DAQ device. Refer to 
the Generic Analog Input section for more information about resource 
conflicts and grounding.
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Connecting Analog Output Signals
This section describes how to connect the AO signals on the prototyping 
board.

Generic Analog Output
The NI  ELVIS provides access to the two DAQ device DACs at the DAC0 
and DAC1 terminals. These channels are used by the NI ELVIS hardware 
for arbitrary waveform generation.

Caution Other functions of the NI ELVIS, such as the DMM and FGEN, internally use 
these DACs and can potentially interfere with the measurements. The driver software 
generates an error message when there is a potential resource conflict.

DC Power Supplies
The DC power supplies output a static ±15 V and +5 V. For more 
information on the DC power supplies output, refer to Appendix A, 
Specifications.

Function Generator (FGEN)
Access to the Function Generator on the prototyping board has several 
additional terminals besides the function generator output signal, 
FUNC_OUT. The SYNC_OUT signal outputs a TTL-compatible clock 
signal of the same frequency as the output waveform. The AM_IN and 
FM_IN signals control the amplitude modulation (AM) and the frequency 
modulation (FM), respectively. These signals are in addition to the fine 
frequency and amplitude controls on the benchtop workstation. 
Software AM is controlled by DAC0 and software FM is controlled by 
DAC1.

Variable Power Supplies
The Variable Power Supplies provide adjustable output voltages from 
0 to +12 V on the SUPPLY+ terminal and –12 to 0 V on the SUPPLY– 
terminal. The GROUND pin provides a connection to the same ground 
of the DC power supplies.
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Connecting Digital I/O Signals
This section describes how to connect the DIO signals on the prototyping 
board.

The DIO circuitry of the NI ELVIS consists of an 8-bit read and write bus, 
four control signals and a 4-bit address bus.

The DO <0..7> signals are the digital outputs of digital circuitry. The 
DI <0..7> signals are the inputs to the digital circuitry. The four control 
lines, WR_ENABLE, LATCH, GLB_RESET, and RD_ENABLE are all 
active-low signals. While data is being written to the write bus, 
WR_ENABLE goes low. While data is being read from the read bus, 
RD_ENABLE goes low. When data is ready on the write bus, LATCH 
pulses. GLB_RESET is connected to the internal reset line, so the 
NI ELVIS internal circuitry can reset the digital circuitry built on the 
prototyping board.

Connecting Counter/Timer Signals
The prototyping board provides access to the DAQ device counter/timer 
inputs, which are also accessible from software. These inputs are used for 
counting TTL signals and for edge detection. The CTR0_SOURCE, 
CTR0_GATE, CTR0_OUT, CTR1_GATE, and CTR1_OUT signals are 
equivalent to the DAQ device GPCTR0_SOURCE, GPCTR0_GATE, 
GPCTR0_OUT, GPCTR1_GATE, and GPCTR1_OUT pins, respectively. 
Refer to the DAQ device user manual for details on counter/timer use and 
configuration.

The FREQ OUT signal is equivalent to the DAQ device FREQ_OUT 
signal. Refer to the DAQ device user manual for more information about 
this signal.

Connecting User-Configurable Signals
The prototyping board provides several different user-configurable 
connectors: four banana jacks, two BNC connectors, and a D-Sub 
connector. Each pin of the connector has a connection to the distribution 
strips of the prototyping board. 

Eight LEDs are provided for general digital output. The anode of each LED 
is connected to the distribution strip through a 220 Ω resistor, and each 
cathode is connected to ground.

Refer to Table 3-1 for more information about the signal names for the 
user-configurable I/O connectors.
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4
Programming NI ELVIS

An NI ELVIS measurement system is composed of the NI ELVIS 
hardware, the DAQ device, and the LabVIEW software that controls the 
hardware. Various measurements can be performed by NI ELVIS using 
either the NI-DAQ driver or the NI ELVIS instrument driver. Three 
standard measurement functions of DAQ devices—AI, AO, and TIO—can 
be utilized when connected to the NI ELVIS Benchtop Workstation. The 
fourth DAQ device function, DIO, is unavailable with an NI ELVIS 
measurement system since the DAQ device DIO communicates with the 
control circuitry of the benchtop workstation. Additionally, the NI ELVIS 
Benchtop Workstation has Variable Power Supplies, a Function Generator, 
a DMM, and DIO that you can control using the NI ELVIS instrument 
driver, which is located in the functions palette under Instrument I/O»
Instrument Drivers»NI ELVIS.

This chapter explains how to program the NI ELVIS hardware using 
NI-DAQ and the NI ELVIS Instrument Driver. This chapter is not intended 
to be an exhaustive guide to programming with LabVIEW or NI-DAQ; its 
purpose is instead to familiarize you with concepts you should know about 
when programming NI ELVIS.

For more information on programming with NI-DAQ or LabVIEW, refer 
to the NI-DAQ documentation that shipped with the device or to the 
LabVIEW Measurements Manual. 

Programming NI ELVIS Using NI-DAQ
This section explains how to program NI ELVIS for AI, AO, and timing 
and control I/O applications. You can find other examples for using 
NI ELVIS for AI, AO, and counter/timer applications by launching 
LabVIEW and selecting Find Examples»Hardware Input and Output» 
DAQ and then the type of example, or you can find examples by selecting 
Find Examples and then searching for NI ELVIS.

Note The DIO examples within LabVIEW do not work with the DIO lines of the 
NI ELVIS hardware. Refer to the Using the DAQ Hardware in Bypass Mode section of 
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Chapter 3, Hardware Overview, for more information about using the communications 
bypass.

Analog Input
You can use NI ELVIS to measure up to six differential AI channels: 
ACH<0..5>.

Note The DAQ device must be configured for differential AI mode before making 
connections to the NI ELVIS Benchtop Workstation. For information on configuring the 
DAQ device, refer to the Measurement & Automation Explorer Help for DAQ, which you 
can access by launching MAX, then selecting Help»Help Topics»NI-DAQ.

ACH<0..5> on the NI ELVIS Prototyping Board directly connect to 
corresponding AI channels on the DAQ device. ACH<0..5> can be used as 
normal input channels for any existing DAQ examples or for when you 
program with the LabVIEW Data Acquisition VIs. ACH5 is also used for 
measurements by the following NI ELVIS software instruments: 
Oscilloscope, DMM, DSA, Impedance Analyzer, Two-Wire 
Current-Voltage Analyzer, and Three-Wire Current-Voltage Analyzer. 
ACH5 might be unavailable if these software instruments are running.

Refer to the NI ELVIS Prototyping Board section of Chapter 3, Hardware 
Overview, for an illustration of signal connections on the prototyping 
board.

Typical AI measurements include buffered continuous acquisitions and 
finite acquisitions with a start trigger. For more information on how to 
perform an AI acquisition using NI-DAQ, refer to the NI-DAQ 
documentation that shipped with the DAQ device.

Caution ACH3 and ACH4 are used for Oscilloscope measurements on CH A and CH B, 
respectively. Do not connect signals to these channels on the prototyping board and the 
front panel BNC Scope connectors at the same time.

Analog Output
NI ELVIS allows access to the two analog outputs of a DAQ device 
through connectors on the prototyping board. The AO signals labeled 
DAC0 and DAC1 connect to the signals of the same name on the 
DAQ device. These signals can be used as normal output channels for 
any existing DAQ examples and for when you program with DAQ VIs.
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Refer to the NI ELVIS Prototyping Board section of Chapter 3, Hardware 
Overview, for an illustration of signal locations on the prototyping board.

The output channels are also used by the following NI ELVIS SFP 
instruments: FGEN, DMM, Impedance Analyzer, Two-Wire 
Current-Voltage Analyzer, and Three-Wire Current-Voltage Analyzer. 
The output channels may not be available if these SFP instruments are 
running.

Typical AO applications include continuous waveform generation and 
single-point output updates. For more information on how to perform 
AO generation using NI-DAQ, refer to the NI-DAQ documentation that 
shipped with the DAQ device.

Timing and Control I/O
NI ELVIS provides access to the two counter/timers of the DAQ device. 
Table 4-1 shows how NI ELVIS counter signals correlate with 
DAQ device timing signals.

CTR0 and CTR1 can be used as normal counter/timers for any existing 
DAQ examples and for when you program with DAQ VIs. The 
counter/timers are also used by the NI ELVIS software Function Generator 
instrument. The counter/timers might be unavailable if the soft front panel 
Function Generator instrument is running.

Refer to the NI ELVIS Prototyping Board section of Chapter 3, Hardware 
Overview, for an illustration of signal connections on the prototyping 
board.

Typical counter/timer applications include pulse train generation, event 
counting, and frequency measurement. For more information on how to 
perform counter/timer measurements using NI-DAQ, refer to the NI-DAQ 
documentation that shipped with the DAQ device.

Table 4-1.  Counter Signal Correlations

NI ELVIS DAQ Device

CTR<0..1>_SOURCE GPCTR<0..1>_SOURCE

CTR<0..1>_GATE GPCTR<0..1>_GATE

CTR<0..1>_OUT GPCTR<0..1>_OUT
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NI ELVIS also provides access to the programmable function input 
(PFI) pins on the DAQ device. These pins are typically used in advanced 
applications that require external control of a measurement. Examples of 
these advanced applications include triggering and scan clock control.

For more information on the PFI pins, refer to the DAQ device user manual. 
For more information on how to use the PFI pins using NI-DAQ, refer to 
the NI-DAQ documentation that shipped with the DAQ device.

Programming NI ELVIS Using the NI ELVIS 
LabVIEW API

An instrument driver is a set of software routines that control a 
programmable instrument. Each routine corresponds to a programmatic 
operation such as configuring, reading from, writing to, and triggering the 
instrument. Instrument drivers simplify instrument control by eliminating 
the need to learn the programming protocol for the instrument.

The NI ELVIS instrument driver is a collection of LabVIEW VIs that 
provides an API for controlling the NI ELVIS hardware. The API allows 
the user to connect VIs in a logical manner to control the instruments of the 
NI ELVIS Benchtop Workstation—the Variable Power Supplies, Function 
Generator, DMM, and DIO. 

The general programming flow when using the NI ELVIS instrument 
driver is Initialization - Action - Close. The initialization VIs establish 
communication with the NI ELVIS Benchtop Workstation and configure 
the selected components to a defined state. A reference (refnum) to the 
specific component is generated and then used by subsequent VIs to 
perform the desired actions.

The instrument driver handles the resource sharing that occurs between the 
components of the NI ELVIS. For example, the DMM uses the Function 
Generator for its measurements. Without resource management, if an 
application using the Function Generator is running, when a DMM 
application runs, one or both applications might return incorrect results. To 
prevent this problem, if the driver detects that a resource is in use, an error 
is returned. Resource management is valid within one LabVIEW process 
only. Therefore, if an application (executable) built using the NI ELVIS 
instrument driver is running at the same time as another application using 
the driver (LabVIEW development environment), resource management is 
not in affect across the processes, and incorrect behavior can occur.
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The NI ELVIS Online Help includes function reference topics for each 
instrument API that lists and describes parameters for each instrument VI.

Note To ensure correct behavior with programs that use NI ELVIS with the instrument 
driver, first you must close the SFP instruments.

You can find other examples for using NI ELVIS for AI, AO, and 
counter/timer applications by launching LabVIEW and selecting
Find Examples»Hardware Input and Output»DAQ and then the type of 
example, or you can find examples by selecting Find Examples and then 
searching for NI ELVIS.

Variable Power Supplies
The NI ELVIS Benchtop Workstation has two variable power supplies that 
can be controlled using the NI ELVIS instrument driver. The driver allows 
the user to select which supply to control and to set its output voltage. 
A simple variable power supply application is shown in Figure 4-1.

Figure 4-1.  Simple Variable Power Supply Application

The supply to control is selected during initialization and then updated 
continuously in the loop. When the loop ends, the supply reference is 
closed and the output is set to zero. The DAQ device number is provided 
to identify the DAQ device that is cabled to the NI ELVIS Benchtop 
Workstation.

Refer to the NI ELVIS Online Help for more information about the specific 
VIs in the variable power supply API.
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Function Generator
The NI ELVIS Benchtop Workstation has a function generator that can be 
controlled using the NI ELVIS instrument driver. The driver allows the 
user to update the frequency, peak amplitude, DC offset, and type of the 
waveform that the function generator outputs. A simple application is 
shown in Figure 4-2.

Figure 4-2.  Simple Function Generator Application

The output of the function generator is set to zero during initialization and 
then the waveform parameters are continuously updated in the loop. When 
the loop ends, the function generator reference is closed and the output is 
set to zero. The DAQ device number is provided to identify the 
DAQ device that is cabled to the NI ELVIS Benchtop Workstation.

The advanced features of the Function Generator—the Tuning and 
AO Modulation controls—can be configured using the 
FGEN-Configure VI. By default, both these features are disabled. The 
refnum that is passed between the API VIs contains information about the 
current configuration state. If the configuration VI is used in a loop, you 
should wire the refnum to shift registers so that the refnum information 
persists between loops.

Refer to the NI ELVIS Online Help for more information about the specific 
VIs in the function generator API. 
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Digital Multimeter

The NI ELVIS Benchtop Workstation contains circuitry that combines 
with the DAQ hardware to allow DMM-type measurements such as 
voltage, current, and resistance. The DMM hardware can be controlled 
using the NI ELVIS instrument driver. The driver allows the user to 
configure the measurement type and read the measurement results. 
A simple application is shown in Figure 4-3.

Figure 4-3.  Simple DMM Application

The type of measurement is configured, the measurement value is returned, 
and then the DMM reference is closed. The DAQ device number is 
provided to identify the DAQ device that is cabled to the NI ELVIS 
Benchtop Workstation. Refer to the DAQ documentation that shipped with 
the DAQ device for more information about device numbers.

The refnum that is passed between the API VIs contains information about 
the current configuration state. If the configuration VI is used in a loop, you 
should wire the refnum to shift registers so that the refnum information 
persists between loops.

Refer to the NI ELVIS Online Help for more information about the specific 
VIs in the DMM API. 

Digital I/O
The DAQ device digital lines are used to control the NI ELVIS Benchtop 
Workstation. Therefore, those lines are not directly accessible on the 
prototyping board. However, the benchtop workstation contains circuitry 
that multiplexes the DAQ DIO lines to provide digital input and output 
signals. The DIO hardware can be controlled using the NI ELVIS 
instrument driver. The driver allows the user to configure the digital 
operation and read or write 8-bit digital data. A simple application to 
perform digital input is shown in Figure 4-4.
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Figure 4-4.  Simple Digital I/O Input Application

The digital operation is configured, the digital data is returned, and then the 
DIO reference is closed

A simple application to perform digital output is shown in Figure 4-5.

Figure 4-5.  Simple Digital I/O Output Application

The digital operation is configured, the digital data is output, and then the 
DIO reference is closed. The DAQ device number is provided to identify 
the DAQ device that is cabled to the NI ELVIS Benchtop Workstation.

Refer to the NI ELVIS Online Help for more information about the specific 
VIs in the DIO API.

Scope
The Oscilloscope component of NI ELVIS is not addressed in the 
instrument driver since you can use NI-DAQ to directly access its 
functionality.
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A
Specifications

This appendix lists the specifications of the NI ELVIS. These specifications 
are typical after a 30 minute warm-up time, at 25 °C, unless otherwise 
noted.

Analog Input
Refer to the Analog Input section of the Specifications of the DAQ device 
user manual.

Arbitrary Waveform Generator1

Number of output channels .................... 2

Maximum frequency .............................. DC to DAQ device
AO update rate/10

Full-power bandwidth ............................ 27 kHz

Output amplitude.................................... ±10 V

Resolution .............................................. 12 bits or 16 bits,
DAQ device dependent

Output drive current ............................... 25 mA

Output impedance .................................. 1 Ω

Slew rate................................................. 1.5 V/µs

Bode Analyzer
Amplitude accuracy ............................... 12 or 16 bits,

DAQ device dependent

Phase accuracy ....................................... 1 degree

Frequency range..................................... 5 Hz–35 kHz

1   The Arbitrary Waveform Generator does not work with the NI 6014 or NI 6024.
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DC Power Supplies

+15 V Supply
Output current.........................................Fused at 500 mA

Output voltage ........................................15 V at ±5% max

Line regulation........................................0.5% max

Ripple and noise .....................................1%

–15 V Supply
Output current.........................................Fused at 500 mA1

Output voltage ........................................–15 V at ±5% max

Line regulation........................................0.5% max

Ripple and noise .....................................1%

+5 V Supply
Output current.........................................Fused at 2 A

Output voltage ........................................+5 V at ±5% max

Line regulation........................................0.50% max

Ripple and noise .....................................1%

Digital I/O
Digital input resolution ...........................8 bits

Digital output resolution .........................8 bits

Digital addressing ...................................4 bits

1   Total current drawn from –15 V supply and variable power supplies cannot exceed 500 mA.
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DMM

Capacitance Measurement
Accuracy ................................................ 1%

Range ..................................................... 50 pF–500 µF in three ranges

Test frequency........................................ 120 or 950 Hz,
software-selectable

Max test frequency voltage .................... 1 Vp-p sine wave,
software-selectable

Continuity Measurement
Resistance threshold............................... 15 Ω max, software-selectable

Test voltage ............................................ 3.89 V, software-selectable

Current Measurement
Accuracy

AC................................................... 0.25% ±3 mA1, 2

DC................................................... 0.25% ±3 mA2

Common-mode voltage.......................... ±20 V max

Common-mode rejection........................ 70 dB min

Range ..................................................... ±250 mA in two ranges, max

Resolution .............................................. 12 bits or 16 bits,
DAQ device dependent

Shunt resistance...................................... 0.5 Ω

Voltage burden....................................... 2 mV/mA

Diode Measurement3
Voltage threshold ................................... 1.1 V max

1   25 Hz to 10 kHz
2   Proper null correction at the common-mode voltage can reduce the ±3 mA offset error to 200 µA of noise.
3   The Two-Wire Current Voltage Analyzer SFP is the recommended instrument for diode measurement.
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Inductance Measurement
Accuracy .................................................1%

Range ......................................................100 µH–100 mH

Test frequency ........................................950 Hz, software-selectable

Test frequency voltage............................1 Vp-p sine wave,
software-selectable

Resistance Measurement
Accuracy .................................................1%

Range ......................................................5 Ω–3 MΩ, in four ranges

Test frequency ........................................120 Hz, software-selectable

Test frequency voltage............................1 Vp-p sine wave,
software-selectable

Voltage Measurement
AC

Accuracy..........................................0.3% ± .001% full-scale1

Range...............................................±14 Vrms in four ranges, max

DC

Accuracy..........................................0.3% ± .001% full-scale, max

Range...............................................±20 V in four ranges, max

Input impedance .....................................1 MΩ

Dynamic Signal Analyzer
Input range ..............................................±10 V in four ranges

Input resolution.......................................12 bits or 16 bits,
DAQ device dependant

Function Generator
Frequency range .....................................5 Hz–250 kHz in five ranges

1   100 Hz to 10 kHz
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Software-controlled
frequency resolution............................... 0.8%

Frequency set point accuracy................. 3% of range, max

Frequency read back accuracy ............... ±0.01%

Output amplitude.................................... ±2.5 V

Software amplitude resolution ............... 8 bits

Offset range............................................ ±5 V

AM voltage ............................................ 10 V, max

Amplitude modulation ........................... Up to 100%

FM voltage ............................................. 10 V, max

Amplitude flatness

To 50 kHz ....................................... 0.5 dB

To 250 kHz ..................................... 3 dB

Frequency modulation............................ ±5% of full-scale, max

Impedance Analyzer
Measurement frequency range ............... 5 Hz–35 kHz

Oscilloscope
Refer to the Analog Input section of Appendix A, Specifications, in the 
DAQ device user manual.

Accuracy ................................................ 12 bits or 16 bits,
DAQ device dependent

Input impedance..................................... DAQ device dependent

Maximum horizontal resolution............. DAQ device dependent

Range ..................................................... ±10 V

Sampling rate per channel...................... 100 kHz–500 kHz,
DAQ device dependent
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Maximum input bandwidth ....................10 kHz–50 kHz,
DAQ device dependent

Vertical resolution ..................................12 bits or 16 bits,
DAQ device dependent

Two-Wire Current-Voltage Analyzer
Current range ..........................................±10 mA

Voltage sweep range...............................±10 V

Three-Wire Current-Voltage Analyzer1

Minimum base current increment...........15 µΑ

Maximum collector current ....................10 mA

Maximum collector voltage....................10 V

Variable Power Supplies

Positive Supply
Output voltage ........................................12 V

Ripple and noise .....................................0.25%

Software-controlled resolution ...............7 bits

Current limiting ......................................0.5 V at 160 mA, 5 V at 275 mA, 
12 V at 450 mA

Negative Supply
Output voltage ........................................–12 V

Ripple and noise .....................................0.25%

Software-controlled resolution ...............7 bits

Current limiting ......................................0.5 V at 130 mA, 5 V at 290mA, 
12 V at 450mA2

1   This SFP instrument is intended for use only with NPN BJT transistors.
2   Total current drawn from –15 V and the negative variable power supply cannot exceed 500 mA.
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Maximum Working Voltage
Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel-to-earth..................................... ±20 V, Installation Category I

Channel-to-channel ................................ ±20 V, Installation Category I

Environmental
Operating temperature............................ 0 to 40 °C

Storage temperature ............................... –20 to 70 °C 

Humidity ................................................ 10 to 90% relative humidity, 
noncondensing

Pollution Degree (indoor use only) ........ 1

Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control and 
laboratory use:

IEC 61010-1, EN 61010-1

UL 3111-1, UL 61010B-1

CAN/CSA C22.2 No. 1010.1

Note For UL and other safety certifications, refer to the product label or to ni.com.

Electromagnetic Compatibility

Emissions:  EN 55011 Class A at 10 m.  FCC Part 15A above 1 GHz

Immunity:  EN 61326:1997 + A2:2001, Table 1

CE, C-Tick and FCC Part 15 (Class A) Compliant

Note For full EMC compliance, you must operate this device with shielded cabling. 
In addition, all covers and filler panels must be installed.
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CE Compliance

This product meets the essential requirements of applicable European 
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility 
Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, click Declarations 
of Conformity Information at ni.com/hardref.nsf/. 
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B
Protection Board Fuses

This appendix describes the fuses on the NI ELVIS Protection Board and 
gives instructions on how to remove the protection board from the 
NI ELVIS Benchtop Workstation, debug the protection board, and change 
fuses.

Removing the Protection Board
The Protection Board detaches from the NI ELVIS Benchtop Workstation 
as shown in Figure B-1. Refer to Where to Start with the NI ELVIS for more 
parts locator diagrams of the NI ELVIS Benchtop Workstation.

Figure B-1.  NI ELVIS Benchtop Workstation with Protection Board Removed

1 NI ELVIS Protection Board 2 NI ELVIS Benchtop Workstation

2

1
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Complete the following steps to remove the protection board from the 
benchtop workstation. Refer to Figure B-1 as needed.

1. Move the NI ELVIS Power Switch to Standby. The Standby switch is 
located on the back side of the benchtop workstation. Refer to Where 
to Start with the NI ELVIS for an illustration of the switch location.

2. Unplug the 68-pin cable and the power supply cable from the benchtop 
workstation

3. Disconnect the prototyping board from the benchtop workstation.

4. Unscrew the captive screws located on the back of the NI ELVIS 
Protection Board.

5. Gently pull on the captive screws to remove the protection board.

Debugging the Protection Board
The protection board provides a level of electrical protection between the 
prototyping board and the motherboard of the NI ELVIS. This protection 
consists of fuses for the high-current signals—such as the power supplies, 
AO channels, and DMM—and 100 Ω current-limited resistors for the 
low-current signals, such as the AI channels, and digital signals. If too 
much current begins to flow to or from a particular signal on the 
prototyping board, the fuse or resistor breaks down, opening the connection 
electrically.

To debug the protection board, you need a DMM with an ohmmeter. 
Complete the following steps:

1. Verify that the NI ELVIS is in Standby mode. The Standby switch is 
located on the back of the NI ELVIS benchtop workstation. 

2. Remove the protection board assembly from the rest of the NI ELVIS 
workstation. For instructions on removing the protection board, refer 
to the Removing the Protection Board section.

3. Check the fuses, since these signals are much more likely to have been 
overloaded. To check the fuse, verify that the resistance across the fuse 
is less than 50 Ω. If all the fuses are operational, proceed to the resistor 
packs.

4. Verify that the resistance across each resistor is 100 Ω, ±5%. One 
resistor is located between each of the following pairs of pins: 
1 and 16, 2 and 15, 3 and 14, 4 and 13, 5 and 12, 6 and 11, 7 and 10, 
and 8 and 9. The resistor packs are socketed so that you can easily 
replace resistors. 
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Caution Before restoring power to the circuit, be sure the problem that caused the 
protection board component to fail has been resolved to keep the same fuse or resistor from 
failing again.

If you need to replace a fuse, use the fuse types listed in Table B-1.

Caution For continued protection against fire, replace only with fuses of the same type and 
rating. Refer to the Table B-1 for fuse types.

Caution The fuses on the NI ELVIS are glass. Use care when removing the fuses to prevent 
injury from broken glass.

Table B-1.  NI ELVIS Fuse Information

Fuse Rating Fuse Type Manufacturer

0.5 A/250 V 5 × 20 mm, 
Slow acting

LittelFuse

0.5 A/250 V 2AG, Fast acting LittelFuse

2 A/250 V 3AG, Fast acting LittelFuse
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Figure B-2 shows the location of the different fuses for the NI ELVIS 
hardware and the location of the resistor packs.

Figure B-2.  Parts Locator Diagram for NI ELVIS Protection Board

Reinstalling the Protection Board
Reinstall the NI ELVIS Protection Board before resuming use of the 
NI ELVIS. To replace the protection board, complete the following steps:

1. Reinsert the PCI connector of the protection board into the benchtop 
workstation rear connector.

2. Tighten the four captive screws located on the back of the protection 
board.

3. Plug in the 68-pin cable and the power supply.

4. Power on the NI ELVIS.

1 DAC<0..1> Fuses
2 3-WIRE Fuse
3 +5 V Fuse

4 ±15 V Fuses
5 Variable Power Supplies Fuses

6 Resistor Packs
7 CURRENT Fuses

3-WIRE

DAC0

DAC1

CURRENT HI 
TO PROTOTYPING BOARD

CURRENT HI 
TO FRONT PANEL

CURRENT  LO
TO PROTOTYPING BOARD

CURRENT LO
TO FRONT PANEL VAR PWR SUPPLY +

VAR PWR SUPPLY - -15 V

+15 V

+5 V
500 mA S.B.        5x20mm
T 0,5 A L 250V 

500 mA F.B.        2AG
F 0,5 A L 250V 

2 A F.B.               3AG
F 2 A L 250V 

Dual-in-line, Isolated, 
100 W, 300 mW Resistor
Networks

! Fire Hazard: 
Do not use plastic chips.

PROTECTION BOARD
NI ELVIS

For Patents: ni.com/patents

R1

R2

R3

RP1 RP8

RP2 RP7

RP3 RP6

RP4 RP5

2

1

3

4

6

7 5
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C
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions, 
visit our extensive library of technical support resources available 
in English, Japanese, and Spanish at ni.com/support. These 
resources are available for most products at no cost to registered 
users and include software drivers and updates, a KnowledgeBase, 
product manuals, step-by-step troubleshooting wizards, 
conformity documentation, example code, tutorials and 
application notes, instrument drivers, discussion forums, 
a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other 
measurement and automation professionals by visiting 
ni.com/support. Our online system helps you define your 
question and connects you to the experts by phone, discussion 
forum, or email.

• Training—Visit ni.com/custed for self-paced tutorials, videos, and 
interactive CDs. You also can register for instructor-led, hands-on 
courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, NI Alliance Program 
members can help. To learn more, call your local NI office or visit 
ni.com/alliance.
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• Declaration of Conformity (DoC)—A DoC is our claim of 
compliance with the Council of the European Communities using the 
manufacturer’s declaration of conformity. This system affords the user 
protection for electronic compatibility (EMC) and product safety. You 
can obtain the DoC for your product by visiting 
ni.com/hardref.nsf.

• Calibration Certificate—If your product supports calibration, you 
can obtain the calibration certificate for your product at 
ni.com/calibration.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

p pico 10–12

n nano 10–9

µ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

Symbols

% percent

– negative of, or minus

+ positive of, or plus

/ per

° degree

Ω ohm

± plus or minus

A

A amperes

AC alternating current

ACH analog input channel signal

ADDRESS the DIO output signals of the address bus

AI analog input
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AIGND analog input ground signal

AISENSE analog input sense signal

AM amplitude modulation—the process in which the amplitude of a carrier 
wave is varied to be directly proportional to the amplitude of the 
modulating signal

AM IN amplification modulation input signal

amplification a type of signal conditioning that improves accuracy in the resulting 
digitized signal and reduces noise

amplitude the voltage amplitude of a signal. When speaking of the amplitude of a 
signal, it is usually assumed to be the RMS value for an AC signal. 
However, amplitude can also refer to the instantaneous amplitude, or the 
peak, peak-to-peak, or average amplitude, if so specified.

AO analog output

ARB arbitrary waveform generator

B

block diagram pictorial description or representation of a program or algorithm. The block 
diagram, consists of executable icons called nodes and wires that carry data 
between the nodes. The block diagram is the source code for the VI. The 
block diagram resides in the block diagram window of the VI.

BNC a type of coaxial signal connector

board refers to the DAQ device

bode plot the plot of the gain and phase of a system as a function of frequency

bus the group of conductors that interconnect individual circuitry in a computer. 
Typically, a bus is the expansion vehicle to which I/O or other devices are 
connected. An example of a PC bus is the PCI bus.
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C

C Celsius

capacitance the ability to hold an electrical charge

CH channel

channel pin or wire lead to which you apply or from which you read the analog or 
digital signal. Analog signals can be single-ended or differential. For digital 
signals, you group channels to form ports. Ports usually consist of either 
four or eight digital channels.

counter/timer a circuit that counts external pulses or clock pulses (timing)

CTR0_GATE counter 0 gate signal

CTR0_OUT counter 0 output signal

CTR0_SOURCE counter 0 source signal

CTR1_GATE counter 1 gate signal

CTR1_OUT counter 1 output signal

CURRENT input signals for current-related measurements for the DMM

D

D/A digital-to-analog

DAC D/A converter

DAQ data acquisition

dB decibel—the unit for expressing a logarithmic measure of the ratio of two 
signal levels: dB = 20log10 V1/V2, for signals in volts

DC direct current

default setting a default parameter value recorded in the driver. In many cases, the default 
input of a control is a certain value (often 0) that means use the current 
default setting.
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DI digital I/O input signals sent to the DI bus

differential input an analog input consisting of two terminals, both of which are isolated from 
computer ground, whose difference is measured

digital trigger a TTL level signal having two discrete levels—a high and a low level

DIO digital I/O

diode a specialized electronic component with two electrodes called the anode 
and the cathode

DMM digital multimeter

DO digital I/O output signals from the DO bus

DOC Canadian Department of Communications

DSA dynamic signal analyzer

E

ECG electrocardiogram

EEPROM electrically erasable programmable read-only memory—ROM that can be 
erased with an electrical signal and reprogrammed

ELVIS Educational Laboratory Virtual Instrumentation Suite

EMC electromechanical compliance

EMI electromagnetic interference

EXTSTROBE external strobe signal

F

FCC Federal Communications Commission

FGEN function generator
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floating signal sources signal sources with voltage signals that are not connected to an absolute 
reference or system ground. Also called nonreferenced signal sources. 
Some common example of floating signal sources are batteries, 
transformers, or thermocouples.

FM_IN frequency modulation input signal

FREQ_OUT frequency output signal

frequency the basic unit of rate, measured in events or oscillations per second using a 
frequency counter or spectrum analyzer. Frequency is the reciprocal of the 
period of a signal.

front panel the user interface of a LabVIEW virtual instrument

FUNC_OUT output signal for the function generator

G

gain the factor by which a signal is amplified, sometimes expressed in decibels

GPCTR0_GATE general purpose counter timer 0 gate signal, available from a DAQ device

GPCTR0_OUT general purpose counter timer 0 output signal, available from a DAQ device

GPCTR0_SOURCE general purpose counter timer 0 clock source signal, available from a
DAQ device

GPCTR1_GATE general purpose counter timer 1 gate signal, available from a DAQ device

GPCTR1_OUT general purpose counter timer 1 output signal, available from a
DAQ device

GPCTR1_SOURCE general purpose counter timer 1 clock source signal, available from a
DAQ device

GROUND prototyping board ground signal
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H

hardware triggering a form of triggering where you set the start time of an acquisition and gather 
data at a known position in time relative to a trigger signal

Hz hertz—the number of scans read or updates written per second

I

I/O input/output—the transfer of data to/from a computer system involving 
communications channels, operator interface devices, and/or data 
acquisition and control interfaces

in. inch or inches

inductance the characteristic of a coil that generates a voltage due to changes in the 
current. An inductor creates a voltage that is the derivative of the current, 
while a capacitor creates a voltage that is the integral of the current.

L

LabVIEW a graphical programming language

LATCH DIO output signal that pulses when data is ready on the write bus

LED light-emitting diode

N

NI-DAQ National Instruments driver software for DAQ hardware

NRSE nonreferenced single ended mode—all measurements are made with 
respect to a common (NRSE) measurement system reference, but the 
voltage at this reference can vary with respect to the measurement system 
ground

O

op-amp operational amplifier—pre-built amplifier modules that are general enough 
to be used almost anywhere an amplifier is needed
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P

PCB printed circuit board

PCI Peripheral Component Interconnect—a high-performance expansion bus 
architecture originally developed by Intel to replace ISA and EISA. It is 
achieving widespread acceptance as a standard for PCs and workstations; 
it offers a theoretical maximum transfer rate of 132 Mbytes/s.

peak to peak a measure of signal amplitude; the difference between the highest and 
lowest excursions of the signal

PFI programmable function input

potentiometer an electrical device the resistance of which can be manually adjusted; used 
for manual adjustment of electrical circuits and as a transducer for linear or 
rotary position

R

RD_ENABLE read enable signal—DIO output signal that indicates when data is being 
read from the read bus

referenced signal
sources

signal sources with voltage signals that are referenced to a system ground, 
such as the earth or a building ground. Also called grounded signal sources.

resistance the resistance to the flow of electric current. One ohm (Ω) is the resistance 
through which one volt of electric force causes one ampere to flow.

rms root mean square

S

s seconds

S samples

S/s samples per second—used to express the rate at which a DAQ device 
samples an analog signal
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SCANCLK scan clock signal

Scope abbreviation for oscilloscope

SYNC_OUT TTL signal of the same frequency of the function generator

T

TIO timing I/O

TRIG trigger signal

trigger any event that causes or starts some form of data capture

TRIGGER trigger input signal for the oscilloscope

TTL transistor-to-transistor logic

V

V volts

VI virtual instrument—a combination of hardware and/or software elements, 
typically used with a PC, that has the functionality of a classic stand-alone 
instrument.

VOLTAGE input signals for the DMM voltmeter

Vp-p peak-to-peak voltage

W

waveform multiple voltage readings taken at a specific sampling rate

WR_ENABLE DIO output signal that indicates data is being written to the write bus
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Index

Symbols
+5 V

+5 V power supply
prototyping board power, 3-6
specifications, A-2

+5V signal
See also DC power supplies
connecting analog output signals, 3-12
signal description (table), 3-8

±15 V
–15 V signal

See also DC power supplies
signal description (table), 3-8

+15 V signal
See also DC power supplies
connecting analog output signals, 3-12
signal description (table), 3-8

±15 V power supply
prototyping board power, 3-6
specifications, A-2

–15 V signal
connecting analog output signals, 3-12

Numerics
3-WIRE signal

See also DMM
connecting analog input signals, 3-11
signal description (table), 3-7

A
academic use of NI ELVIS, 2-7, 2-8
ACH<0..5>– signals

analog input signal mapping (table), 3-10
signal description (table), 3-7

ACH<0..5>+ signals
analog input signal mapping (table), 3-10
signal description (table), 3-7

ADDRESS <0..3> signals
See also digital I/O
signal description (table), 3-8

AIGND signal
analog input signal mapping (table), 3-10
connecting analog input signals, 3-10
signal description (table), 3-7

AISENSE signal
analog input signal mapping (table), 3-10
connecting analog input signals, 3-10
signal description (table), 3-7

AM_IN signal
See also function generator
connecting analog output signals, 3-12
signal description (table), 3-8

analog input
connecting signals, 3-9
resource conflicts, 3-11
signal mapping (table), 3-10

analog input software instruments
bode analyzer SFP, 2-5
DMM SFP, 2-5
DSA SFP, 2-6
impedance analyzer SFP, 2-6
scope SFP, 2-6
three-wire current-voltage analyzer 

SFP, 2-7
two-wire current voltage analyzer SFP, 2-7

analog output
connecting signals, 3-12
software instruments

ARB SFP, 2-4
FGEN SFP, 2-6
variable power supplies, 2-7
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analog output instruments
hardware

function generator
controls, 3-3
overview, 2-3

variable power supplies
controls, 3-3
overview, 2-3

API
overview, 2-7

ARB SFP overview, 2-4

B
BANANA <A..D> signals

connecting user configurable I/O signals, 
3-13

connector locations (figure), 3-6
signal description (table), 3-8

benchtop workstation
controls and indicators, 3-2
overview, 2-3
parts locator diagram, 3-2
removing the protection board, B-1

BNC <1..2>– signals
connecting user configurable I/O 

signals, 3-13
signal description (table), 3-8

BNC <1..2>+ signals
connecting user configurable I/O 

signals, 3-13
signal description (table), 3-8

bode analyzer
specifications, A-1

bode analyzer SFP
overview, 2-5

bypass mode
communications switch

location (figure), 3-2
description, 3-2

C
calibration certificate, C-2
CH <A..B>– signals

See also oscilloscope
connecting analog input signals, 3-11
signal description (table), 3-7

CH <A..B>+ signals
See also oscilloscope
connecting analog input signals, 3-11
signal description (table), 3-7

communications switch
location (figure), 3-2

configuring the NI ELVIS, 2-4
connecting signals on the prototyping board

analog input
DMM, 3-11
generic analog input, 3-10
grounding, 3-9
oscilloscope, 3-11
resource conflicts, 3-11

analog output
DC power supplies, 3-12
function generator, 3-12
generic analog output, 3-12
variable power supplies, 3-12

counter/timer signals, 3-13
digital I/O, 3-13
user-configurable signals, 3-13

contacting National Instruments, C-2
conventions used in the manual, ix
counter/timers, connecting signals, 3-13
CTR0_GATE signal

connecting counter/timer signals, 3-13
counter signal correlations (table), 4-3
signal description (table), 3-9

CTR0_OUT signal
connecting counter/timer signals, 3-13
counter signal correlations (table), 4-3
signal description (table), 3-9
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CTR0_SOURCE signal
connecting counter/timer signals, 3-13
counter signal correlations (table), 4-3
signal description (table), 3-9

CTR1_GATE signal
connecting counter/timer signals, 3-13
counter signal correlations (table), 4-3
signal description (table), 3-9

CTR1_OUT signal
connecting counter/timer signals, 3-13
counter signal correlations (table), 4-3
signal description (table), 3-9

CTR1_SOURCE signal
counter signal correlations (table), 4-3

CURRENT HI signal
See also DMM
connecting analog input signals, 3-11
signal description (table), 3-7

CURRENT LO signal
See also DMM
connecting analog input signals, 3-11
signal description (table), 3-7

customer
education, C-1
professional services, C-1
technical support, C-1

D
D0 <0..7> signals

signal description (table), 3-8
DAC<0..1> signals

See also analog output, 3-8
connecting analog output signals, 3-12
internally using (caution), 3-12
signal description (table), 3-8

DAQ hardware
definition, 1-1
NI ELVIS components (figure), 2-2
overview, 1-2

system requirements, 3-1
using the hardware in bypass mode, 3-1

DC power supplies
prototyping board power, 3-6
signal descriptions (table), 3-8
specifications

+5 V power supply, A-2
±15 V supply, A-2

debugging the protection board, B-2
Declaration of Conformity, C-2
DI <0..7> signals

See also digital I/O
connecting digital I/O signals, 3-13
signal description (table), 3-8

diagnostic resources, C-1
digital bus reader SFP

overview, 2-5
digital bus writer SFP

overview, 2-5
digital I/O

connecting signals, 3-13
DAQ hardware requirements, 3-1
DIO lines (bypass mode), 3-1
LabVIEW API, 4-7
signal descriptions (table), 3-8
software instruments

digital bus reader, 2-5
digital bus writer SFP, 2-5

digital multimeter. See DMM
DMM

connecting signals, 3-11
connectors

description, 3-4
location (figure), 3-2

internally using the DACs (caution), 3-12
LabVIEW API, 4-7
overview, 2-5
signal descriptions (table), 3-7, 3-8
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specifications
current measurement, A-3
voltage measurement, A-4

DO <0..7> signals
connecting digital I/O signals, 3-13

documentation
conventions used in manual, ix
online library, C-1
related documentation, x

drivers
instrument, C-1
software, C-1

DSA SFP overview, 2-6
DSUB PIN signals

signal description (table), 3-9
DSUB SHIELD signal

signal description (table), 3-9

E
electromagnetic compatibility 

specifications, A-7
ELVIS

components (figure), 2-2
hardware overview, 2-2
LabVIEW API, 2-7
overview, 2-1
software overview, 2-3

example code, C-1

F
FGEN. See function generator
FM_IN signal

See also function generator
connecting analog output signals, 3-12
signal description (table), 3-8

FREQ_OUT signal
connecting counter/timer signals, 3-13
signal description (table), 3-9

FUNC_OUT signal
See also function generator
connecting analog output signals, 3-12
signal description (table), 3-8

function generator
connecting signals, 3-12
hardware

controls description, 3-3
controls location (figure), 3-2

LabVIEW API, 4-6
overview, 2-6
signal descriptions (table), 3-8
specifications, A-4

fuses, debugging the protection board, B-2

G
GLB_RESET signal

See also digital I/O
connecting digital I/O signals, 3-13
signal description (table), 3-8

GROUND signal
See also DC power supplies; variable 

power supplies
connecting analog output signals, 3-12
signal description (table), 3-8

H
help

professional services, C-1
technical support, C-1

I
I/O connectors

I/O connector descriptions, 3-13
location (figure), 3-6
signal descriptions (table), 3-7

impedance analyzer SFP overview, 2-6
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installation
category, 1-6

instrument drivers, C-1
instrument launcher, 2-4
instrumentation, virtual, 1-3

K
KnowledgeBase, C-1

L
LabVIEW

NI ELVIS software instruments, 2-3
overview, 1-3
programming NI ELVIS

digital I/O, 4-7
DMM, 4-7
FGEN, 4-6
overview, 4-4
variable power supplies, 4-5

virtual instrumentation, 1-3
LATCH signal

See also digital I/O
connecting digital I/O signals, 3-13
signal description (table), 3-8

launcher, instrument, 2-4
LED <0..7> signals

connecting user configurable I/O 
signals, 3-13

signal description (table), 3-9

M
manual mode

function generator, 3-3
variable power supplies, 3-3

N
National Instruments

calibration certificate, C-2
customer education, C-1
Declaration of Conformity, C-2
professional services, C-1
system integration services, C-1
technical support, C-1
worldwide offices, C-2

NI ELVIS
configuring, 2-4
instrument launcher, 2-4
overview, 1-4

benchtop workstation, 2-3
DAQ hardware, 1-2
LabVIEW, 1-3
prototyping board, 2-3

parts locator diagram, 2-2
using in academic disciplines, 2-7, 2-8

normal mode, communications switch, 3-1

O
online technical support, C-1
oscilloscope

connectors (figure), 3-2
connectors on benchtop workstation, 3-4
overview, 2-6
signal descriptions (table), 3-7
specifications, A-5

P
PFI<1..2> signals

signal description (table), 3-7
PFI<5..7> signals

signal description (table), 3-7
phone technical support, C-2
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power supply
DC. See DC power supply
prototyping board, 3-6
variable. See variable power supplies

professional services, C-1
programmable function I/O

PFI<1..2> signals, 3-7
PFI<5..7> signals, 3-7
RESERVED signal, 3-7
SCANCLK signal, 3-7

programming examples, C-1
programming NI ELVIS

NI-DAQ
analog input, 4-2

overview, 4-1
using LabVIEW

DIO, 4-7
DMM, 4-7
function generator, 4-6
overview, 4-4
Scope, 4-8
variable power supplies, 4-5

using NI-DAQ
analog output, 4-2
overview, 4-1
timing and control I/O, 4-3

protection board
debugging, B-2
overview, 3-4
reinstalling, B-4
removing the protection board, B-1

prototyping board
connecting signals

analog input
DMM, 3-11
generic analog input, 3-10
grounding, 3-9
oscilloscope, 3-11
resource conflicts, 3-11

analog output
DC power supplies, 3-12
function generator, 3-12
generic analog output, 3-12
variable power supplies, 3-12

counter/timer signals, 3-13
digital I/O, 3-13

overview, 2-3, 3-5
parts locator diagram, 3-6
power supply, 3-6
power switch (figure), 3-2
signal descriptions (table), 3-7

pulse generator
DAQ hardware in bypass mode, 3-2

R
RD_ENABLE signal

See also digital I/O
connecting digital I/O signals, 3-13
signal description (table), 3-8

related documentation, x
removing the protection board, B-1
requirements, DAQ hardware, 3-1
RESERVED signal

signal description (table), 3-7

S
safety information, 1-5
safety specifications, A-7
SCANCLK signal

signal description (table), 3-7
Scope. See oscilloscope
SFP instruments

ARB, 2-4
bode analyzer, 2-5
digital bus reader SFP, 2-5
digital bus writer, 2-5
DMM, 2-5
DSA, 2-6
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FGEN, 2-6
impedance analyzer, 2-6
instrument launcher, 2-4
overview, 2-3
Scope, 2-6
three-wire current-voltage analyzer, 2-7
variable power supplies, 2-7

signal connections
I/O connector

signal descriptions (table), 3-7
software drivers, C-1
software mode

function generator, 3-3
variable power supplies, 3-3

specifications
analog input, A-1
bode analyzer, A-1
DC power supplies

+5 V supply, A-2
±15 V supply, A-2

DMM
current measurement, A-3
voltage measurement, A-4

electromagnetic compatibility, A-7
function generator, A-4
oscilloscope, A-5
safety, A-7
variable power supplies

negative supply, A-6
positive supply, A-6

SPF instruments
two-wire current voltage analyzer, 2-7

SUPPLY– signal
See also variable power supplies
connecting analog output signals, 3-12
signal description (table), 3-8

SUPPLY+ signal
See also variable power supplies
signal description (table), 3-8

support
technical, C-1

SYNC_OUT signal
See also function generator
connecting analog output signals, 3-12
signal description (table), 3-8

system integration services, C-1
system power LED (figure), 3-2

T
technical support, C-1
telephone technical support, C-2
three-wire current voltage analyzer SFP 

overview, 2-7
training

customer, C-1
TRIGGER signal

See also oscilloscope
connecting analog input signals, 3-11
signal description (table), 3-7

troubleshooting resources, C-1
two-wire current voltage analyzer SFP 

overview, 2-7

U
user configurable I/O

BANANA signals, 3-8
BNC <1..2>– signals, 3-8
BNC <1..2>+ signals, 3-8
DSUB pin <0..9> signals, 3-9
DSUB shield, 3-9
LED <0..7> signals, 3-9

user-configurable I/O
connecting signals, 3-13
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V
variable power supplies

hardware controls, 3-3
hardware controls (figure), 3-2
LabVIEW API, 4-5
overview, 2-7
signal descriptions (table), 3-8
specifications

negative supply, A-6
positive supply, A-6

virtual instrumentation, 1-3
VOLTAGE HI

signal description (table), 3-7
VOLTAGE HI signal

See also DMM
connecting analog input signals, 3-11

VOLTAGE LO
signal description (table), 3-8

VOLTAGE LO signal
See also DMM
connecting analog input signals, 3-11

VOLTAGE– signal
signal description (table), 3-8

VOLTAGE+ signal
signal description (table), 3-7

W
Web

professional services, C-1
technical support, C-1

worldwide technical support, C-2
WR_ENABLE signal

See also digital I/O
connecting digital I/O signals, 3-13
signal description (table), 3-8
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